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Press Command-J (PC: Ctrl-J) to copy
the selection up onto a new layer. Then,
go back to the duplicate image we ap-
plied the HDR Toning to, get the Move
tool (V), and click-and-drag it over to
the file with the selection on a new layer.
Make sure to press-and-hdld the Shift
key as you drag to line the two images
up. Once it's in place, press Command-
Option-G (PC: Ctrl-Alt-G) to clip this
layer inside the extracted layer just
below. Then, change the clipped
layer’s blend mode to Soft Light.

Command-click on the original
extracted layer to select both it
and the top layer, and then nest
them into a smart object by Right-
clicking on one and choosing Con-
vert to Smart Object. Then, click-
and-drag this Smart Object layer into
the working layout (with the blue-to
black gradient). Press Command-T
(PC: Ctrl-T) to go into Free Trans-
form, then press Command-0 (zero;
PC: Ctrl-0) to see the Free Transform
handles, and scale your subject down
to fit in the frame (press-and-hold
the Shift key while you drag to keep
it proportional). Press Return (PC:
Enter) when you're done.
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STEP 15:

Go ahead and open up the first
water splash image that we’re going
to composite with the dancer image.
To extract the splash, open the Chan-
nels panel (under the Window menu),
then press-and-hold the Command
(PC: Ctrl) key while clicking on the
RGB composite channel. This will
load the brightness, or luminosity,
of the image as a selection.

STEP 14:

Press Command-Shift-1 (PC: Ctrl-
Shift-1) to Inverse the selection. Then,
go to the Layers panel and click on
the Create a New Layer icon to create
a new blank layer. Press Shift-Delete
(PC: Shift-Backspace) and choose
White from the Fill dialog’s Use pop-
up menu to fill the active selection
with white. Press Command-D (PC:
Ctrl-D) to Deselect. Click back on the
Background layer, press Shift-Delete
again, but this time choose Black
from the Use pop-up menu to fill
the Background layer with black.
Now you can see a nicely extracted
white water splash.
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Now, with the Move tool, click-and-drag
the water splash layer over to your work-
ing layout. (Here, | turned off the dancer
layer, so you could see the water splash
better.) Go into Free Transform mode,
then scale and rotate the water splash to
fit in the composition just as you see it
here. Press Return when you're done.

Let’s add a layer style to it to enhance
the highlights a bit more. Click on the
Add a Layer Style icon at the bottom of
the Layers panel and, from the pop-up
menu, choose Bevel and Emboss. Set
the Style to Inner Bevel, the Technique
to Smooth, the Depth to 780%, the
Direction to Down, the Size to 5 px,
and leave Soften at 0 px. Next, turn
off the Use Global Light checkbox, and
set the Angle to 45° and the Altitude
to 53°. Then, set the Highlight Mode
to Linear Dodge (Add), its Opacity
to 100%, the Shadow Mode to Color
Dodge, its Opacity to 100%, and the
shadow color to a lighter gray (I used
R: 213, G: 213, B: 213). Try to vary these
settings as you apply them to see the
different looks that are possible. You
may even stumble on something that
works better for you. How do you think
| got to these settings? Click OK and
then change the layer’s blend mode
to Overlay.
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STEP 17:

Press Command-J (PC: Ctrl-J) to
make a duplicate of this splash layer

to intensify the water effect on the
background even more. If it seems too
intense, just lower the layer’s Opacity
setting. If you turned if off, turn the
dancer’s layer back on again, and click-
and-drag it to the top of the layer stack
in the Layers panel, so he appears in
front of the water.

STEP 18:

Now, open the second water splash
image and extract this splash the same
way we did the first one. When you're
done, bring it over to the working lay-
out and use Free Transform to scale
it down, so it looks like what you
see here.
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STEP 19:

Next, apply the same layer style we
applied to the first splash by Option-
dragging (PC: Alt-dragging) the
layer style (fx) icon on the first splash
layer to the second splash layer. Also,
remember to change the layer’s blend
mode to Overlay.

STEP 20:
Now, just duplicate this splash layer,

like we did with the first one, to make
it brighter. This will add to the effect
of the dancer colliding with the water.
We'll make that happen next.

Continued
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Click back on the first splash layer
we added to make it active and then
make another duplicate of it. Press
Command-T (PC: Ctrl-T) to go into
Free Transform mode, then Right-click
inside the bounding box and choose
Flip Horizontal. Press Return (PC:
Enter) to lock in your change.

For better visibility, turn off all the
other splash layers by clicking on the
Eye icons next to their image thumb-
nails, leaving just this one splash and
the dancer. Click-and-drag the layer to
the top of the layer stack, so it looks
like it's in front of the dancer. Now, put
the splash into Free Transform mode
once again, scale it down, and rotate
it around, so that its positioning is sim-
ilar to what you see here. This is the
splash we're going to make a displace-
ment map from to distort the dancer.
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Make a duplicate of this file by going
under the Image menu and choosing
Duplicate. Turn off all the layers, ex-
cept this splash layer we just rotated
and the Background layer. Click on the
Background layer, press Shift-Delete
(PC: Shift-Backspace), choose 50%
Gray from the Fill dialog’s Use pop-up
menu, and click OK. What you should
have is that newly repositioned water
splash against a gray background. This
is our displacement map. The Displace
feature affects an image based on the
light and dark areas of another image.
Gray areas are ignored, so, in this case,
the image will only be affected by the
white areas of the splash. Go under the
Layer menu and choose Flatten Image
(you can discard the hidden layers), then
save this file to your desktop and close it.

Go back to your original working lay-
out file and click on the Smart Object
layer of the dancer to make it active. Go
under the Filter menu, under Distort,
and choose Displace. Set the Horizontal
and Vertical Scale each to 50. Leave the
other settings as they are, and click OK.
When the Choose a Displacement Map
dialog appears, locate the displace-
ment file you just created, select it,
then click Open. Notice how the dancer
now appears to be distorted through
the splashing water, making it seem
more believable that he’s colliding with
the water. Turn all the other splash layers
back on by clicking where their Eye icons
used to be.
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Press-and-hold the Command (PC: Ctrl)
key and click on the image thumbnail
for the splash layer that we used to cre-
ate the displacement map (Layer 2 copy
2) to load it as a selection. Then, click on
the dancer layer and Option-click (PC:
Alt-click) on the Add Layer Mask icon at
the bottom of the Layers panel. This will
hide the subject in the area where the
distortion is, adding to the effect.

To make it look more like his foot is
plunging through the water, duplicate
the first water splash layer we used one
more time, drag it to the top of the
layer stack, then use Free Transform to
scale and rotate it to cover his foot, so
it looks like what you see here.
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Now, on the dancer layer’s layer mask,
we're going to make the foot look like
itis disintegrating as it passes through
the water. Get the Gradient tool again
and, in the Options Bar, make sure you
are using the Foreground to Trans-
parent gradient (the second icon from
the left in the top row of the Gradient
Picker). Change the tool’s blend Mode
to Dissolve and lower the Opacity to
75%. Also, make sure you have the
Radial Gradient icon selected and your
Foreground color is black. Now, with
the layer mask (on the dancer layer)
active, start at the tip of the shoe and
draw the gradient just a little way up.
Combined with the water effect, the
foot will look like it is just disintegrat-
ing away. As you move up the foot and
leg, though, it looks a little too speck-
led, so take the Blur tool (right below
the Gradient tool in the Toolbox), re-
duce the Strength to 25%, and paint
over the back of the foot and up the
leg. This blends it better and makes it
look more like solid water.

To make him stand out more, click on
the image thumbnail of the dancer, then
click on the Add a Layer Style icon at the
bottom of the Layers panel and choose
Outer Glow. Change the Blend Mode
to Overlay, set the Opacity to 100%,
click on the color swatch and change it
to white, then set the Size to 104 pX,
and click OK.
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STEP 29:

After adding the glow, | think the colors
in the dancer’s clothing need to be more
saturated. So, click on the Create New
Adjustment Layer icon at the bottom
of the Layers panel, and choose Hue/
Saturation. In the Adjustments panel,
drag the Saturation slider to +25. To
make the adjustment only apply to him,
press Command-Option-G (PC: Ctrl-
Alt-G) to clip the adjustment layer to
the dancer layer.

STEP 30:

As a final element, | added a distorted
white shape in the background (just
above the Background layer) to help
bring the elements together (I turned
off all the other layers, so you could
see it better). To do this, | drew a rect-
angle with the Rectangle tool set to
Fill Pixels, and my Foreground color set
to white. Then, | went into Free Trans-
form, Right-clicked and chose Warp,
chose Bulge from the Warp pop-up
menu in the Options Bar, grabbed the
top-center control handle, and dragged
down a bit. Then, | Right-clicked again
and chose Skew, and angled it so it
was higher on the left. | added a Drop
Shadow layer style to it (using the set-
tings shown here), and hid part of it
behind the dancer by adding a layer
mask and drawing a black radial gradi-
ent on it. Was it really needed? Not
necessarily, but [ like it.
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STEP ONE:

start by going under the File menu,
choosing New, and creating a new
blank document that is almost 6 inches
wide by 8.5 inches tall at 100 ppi.

STEP TWO:

Select the Gradient tool from the Tool-
box (or press G). Press D to set your
Foreground and Background colors to
their defaults of black and white, and
then press X to invert them, so that
black is the Background color. Click on
the white Foreground color swatch at
the bottom of the Toolbox, and set
the RGB colors to R: 30, G: 109, B: 178.
Click OK.

that you just can't get
to combine a ph
or just plain impractical to try to

era. Especially when it comes to the unpredictable

in the cam
r with some water elements

oto of a dancer jumping in the ai
shoot.

| Widch:[5.84 =
Height:[85 | (inches ) ot !
Resolution: [100 | Cpixelsfincn 189 | (Device Central... |

s |
| '.

|
|
‘ Color Mode: | RGE Color 1] (8 bit
H Background Contents: | White | I
! S e | imagesize:
| (=) Advanced | S s
|
]

2. Emons |

« ( Cancel )
-3 ¥
T L |
- |

S
T, [
ey @u: [208]° Ou |44 I
S Os [Bx O=ls] |
{7: Ow [0]x Ob: [-44]
Q Or [30] clsr s !
i"' O [109] wse % |
wlll  (only Web Colors QOB [178] vz 1% |
E_ #[1e6db2 | Ko |% 8
" - o = s = 7 wy‘g

£
LL Ehaplers = Design Effects





image3.jpeg
moverse @ Ditner M Tearsparency

B spisch.psd @ 100 RGB/E)

\ G Dec LA b

07062508Mediumjp:

Dec semsam b

©ISTOCKPHOTO/ALEXANDER YAKOVLEV

CHAPTER

With the Gradient tool selected, go to
the Options Bar and click on the down-
facing arrow to the right of the gradient
thumbnail to open the Gradient Picker.
Choose the Foreground to Background
gradient (the first one in the top row),
then click on the Radial Gradient icon
(the second icon to the right of the
gradient thumbnail) to choose it. Now,
click-and-drag the gradient out from
the center of the canvas area. It doesn’t
need to be perfectly centered, but close.

Next, open the image of the dancer.
The position of the subject in this
image lends itself well to the effect
we're going for here. However, |
would like to grunge it up a bit to
give the subject some texture. The
HDR Toning feature (new to CS5)
will work great for this.

Continued
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STEP FIVE:

The HDR Toning feature, though, will
only work on a flattened image, mean-
ing you cannot have any layers except
the base Background layer. But, we're
going to need him selected off that
background later, so make a duplicate
of the entire file by going under the
Image menu and choosing Duplicate.

STEP SIX:

With this duplicate file active, go under
the Image menu, under Adjustments,
and choose HDR Toning. | would hon-
estly rather call this the grunge feature,
because while it does give you a decent
fake-HDR look, | like to use it to get a
really high-contrast grunge look.
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CHAPTER

STEP SEVEN:

As I've learned using this feature, there
is no real formula for what works. Each
image is different. The best thing to do
is to experiment and see what works and
what does not. For this image, | started
by first increasing the Detail setting to
+133% in the Tone and Detail section.
Since | planned to blend this adjusted
image with the original, | went ahead
and dropped the Saturation to -100%,
removing all color. Then, | moved up
to the Radius and Strength sliders and
dragged them to the right to modify the
effect and fine-tune the detail areas.

| also nudged the Gamma up a little
and dropped the Vibrance to -100%. If
the image gets too bright in some areas,
you can lower the Exposure to recover
some lost detail. Again, feel free to play
around with this dialog, as there are nu-
merous possibilities to create interesting
image effects. Sometimes, color satura-
tion can make things worse, so remem-
ber to perhaps lower the Saturation to
recover detail lost by color saturation.

STEP EIGHT:

If you like the final effect, you can save
it as a preset by clicking on the Preset
Options icon to the right of the Preset
pop-up menu, and choosing Save Pre-
set. Name your preset and click Save.
Now your preset will appear in the
Preset pop-up menu.
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STEP NINE:

Click OK in the HDR Toning dialog
when you're done. Now, the result |
looks pretty good, but | want to
increase the contrast just a tad more
by running a quick Levels adjustment
(press Command-L [PC: Ctrl-L]). You
can see here, | made the light areas
considerably brighter and only made
the dark areas just a little darker.

Eoe) |

| Preset: [ Custom
et fah b i) s e € Cancel =
Inpiteveloy A SSIALRRE Lanete i
] vy
i
# Preview
STEP 10:
Now, go back to the original dancer
image and then choose the Quick |
Selection tool (W) from the Toolbox
(it's grouped with the Magic Wand - View Mode e
tool). Click-and-drag over the subject 3 M ) Show Radiss 0
to select him and then click on the Re- [ 3 Show Original 1)

fine Edge button in the Options Bar
to fine-tune the selection. Here, | went
ahead and turned on the Smart Radius
checkbox, and increased the Radius |
only slightly to 1.4. In the Output sec-
tion, set the Output To pop-up menu
to Selection, then click OK.
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